
RSA® Authentication Manager 8.1 Virtual Appliance 
Getting Started

Thank you for purchasing RSA® Authentication Manager 8.1, the world’s leading two-factor 
authentication solution. This document provides an overview of how to deploy Authentication Manager. 

Step 1: Prepare for Deployment

A: Download the License File

Download the license file (.zip) from RSA Download Central at https://download.rsasecurity.com. 
Do not unzip the file.

Use the credentials and the license serial number that RSA e-mailed to you to log on to the site and 
download the license file. If you did not receive an e-mail with the logon credentials, contact the 
License Seed Response Team by sending an e-mail with your contact information and license serial 
number (provided in your order confirmation) to the regional address for your area listed below:

• Americas: license_seed_response@rsa.com

• EMEA: support@rsa.com

• Asia Pacific: support@rsa.com

Before running Quick Setup for the primary appliance, locate the license file, and make sure it is 
accessible to the browser that is used to run Quick Setup. RSA recommends that you store the license 
file in a protected location that is available only to authorized administrative personnel.

B: Locate the Documentation Set

The documentation set is available on RSA SecurCare Online at https://knowledge.rsasecurity.com. 
RSA recommends that you store the user documentation in a network location that your administrators 
can access.

C: Plan Your Deployment

RSA recommends that you read the Planning Guide before you deploy, and refer to the Setup and 
Configuration Guide for complete requirements and configuration instructions. To plan a more secure 
deployment, see the Security Configuration Guide.

Collect the following required network information:

• The hostname or IP address of at least one Network Time Protocol (NTP) server. Authentication 
Manager requires accurate time for authentication and replication.

• The network information for each appliance: the fully qualified domain name (FQDN), static IP 
address, subnet mask, default gateway, and DNS server IP addresses.

For additional requirements, see “Setup and Configuration Information List” in the first chapter of the 
Setup and Configuration Guide. 
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D: Read the Release Notes

Locate the RSA Authentication Manager 8.1 Service Pack 1 Release Notes (am_release_notes.html) 
on RSA SecurCare Online at https://knowledge.rsasecurity.com. The Release Notes provide 
important information about this release, as well as workarounds for known issues.

Step 2: Meet the Prerequisites

RSA Authentication Manager 8.1 supports a VMware virtual appliance and a Hyper-V virtual 
appliance.

VMware Prerequisites

The following table lists the requirements for deploying RSA Authentication Manager 8.1 on a 
VMware virtual appliance.

VMware Software Requirements

Deploy the virtual appliance on one of the following platforms:

• VMware ESXi 4.1 or later (VMware vSphere Hypervisor 4.1 or later)

• VMware ESXi 5.0 or later (VMware vSphere Hypervisor 5.0 or later)

Any version of the VMware vSphere Client that can connect to and manage supported ESXi (Hypervisor) and 
vCenter Server deployments.

VMware Software Support

(Optional) Versions of VMware vCenter Server that are compatible with the supported ESXi (Hypervisor) 
versions.

Primary or Replica Instance Requirements

The VMware virtual appliance for each RSA Authentication Manager 8.1 instance requires hardware that 
meets or exceeds the following minimum requirements:

• 100 GB of disk space for storage and 4 GB for a swap file

• 4 GB of memory

• At least one virtual CPU

By default, each Authentication Manager instance is deployed with 8 GB of memory and two virtual CPUs.

The virtual appliance may require additional disk space for virtual machine operations, such as snapshots and 
memory management. Use the following formula to calculate the total amount of storage required:

Total disk space = 104 GB + (GB of memory allocated to the virtual appliance x 2) + (Number of snapshots x 
GB of memory allocated to the virtual appliance)

For example, a virtual appliance with 8 GB of memory and three snapshots requires about 150 GB of storage. 
The calculation 104 GB + (2 x 8 GB of memory) + (3 snapshots x 8 GB of memory) indicates that 144 GB is 
required, or 150 GB if you include a 6 GB buffer. 

Automatic tuning on the virtual appliance supports 4 GB, 8 GB, or 16 GB of memory. For example, the 
appliance uses 16 GB of memory if more than 16 GB is available.
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Hyper-V Prerequisites

The following table lists the requirements for deploying RSA Authentication Manager 8.1 on a 
Hyper-V virtual appliance.

The VMware virtual appliance only supports the E1000 virtual network adapter. Do not change the default 
network adapter or add a new virtual network adapter to the virtual appliance.

For additional hardware requirements for the physical server hosting the virtual appliances, see your VMware 
documentation.

Supported Browsers on a Windows Client

• Microsoft Internet Explorer 7.0 or later

• Mozilla Firefox 10.0 or later

• Google Chrome 18 or later

• Apple Safari 5.1 or later

Supported Directory Servers for User Data Storage

• Authentication Manager internal database

• Microsoft Active Directory 2008 R2

• Microsoft Active Directory 2012

• Microsoft Active Directory 2012 R2

• Sun Java System Directory Server 7.0

• Oracle Directory Server Enterprise Edition 11g

Hyper-V Software Requirements

On a Microsoft Windows 2012 R2 host machine, deploy the Hyper-V virtual appliance with one of the 
following tools:

• Hyper-V System Center 2012 R2 Virtual Machine Manager (VMM). Use the Windows PowerShell version 
that is included with the VMM Console installation.

• Hyper-V Manager 2012 R2. Use the Windows PowerShell version that is included with Windows 2012 R2.

Windows PowerShell 4.0 or later is required. 

If you are using VMM, verify that the required Hyper-V and VirtualMachineManager PowerShell modules are 
available. Run these two PowerShell commands to display a list of commands related to each module:

Get-Command -Module Hyper-V

Get-Command -Module VirtualMachineManager

For more information, see your Hyper-V documentation.

If you are using Hyper-V Manager, then install both the Hyper-V role and the management tools. For example, 
if you use Server Manager to install the Hyper-V role, the management tools are included by default. For 
instructions, see your Hyper-V documentation.
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Primary or Replica Instance Requirements

The Hyper-V virtual appliance for each RSA Authentication Manager 8.1 instance requires hardware that 
meets or exceeds the following minimum requirements:

• 100 GB of disk space for storage and 4 GB for a swap file

• 4 GB of memory

• At least one virtual CPU

By default, each Authentication Manager instance is deployed with 8 GB of memory and two virtual CPUs.

The virtual appliance may require additional disk space for virtual machine operations, such as checkpoints 
and memory management. For example, you may need 150 GB in total storage, or you may need 200 GB in 
total storage if you are using 16 GB of memory. 

Automatic tuning on the virtual appliance supports 4 GB, 8 GB, or 16 GB of memory. For example, the 
appliance uses 16 GB of memory if more than 16 GB is available.

The Hyper-V virtual appliance provides a virtual network adapter that uses the hv_netvsc  driver. Do not use 
the legacy network adapter. The legacy network adapter is not supported.

For additional hardware requirements for the physical server hosting the virtual appliances, see your Hyper-V 
documentation.

Supported Browsers on a Windows Client

• Microsoft Internet Explorer 7.0 or later

• Mozilla Firefox 10.0 or later

• Google Chrome 18 or later

• Apple Safari 5.1 or later

Supported Directory Servers for User Data Storage

• Authentication Manager internal database

• Microsoft Active Directory 2008 R2

• Microsoft Active Directory 2012

• Microsoft Active Directory 2012 R2

• Sun Java System Directory Server 7.0

• Oracle Directory Server Enterprise Edition 11g
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Step 3: Deploy the Virtual Appliance

Deploy RSA Authentication Manager 8.1 on a VMware virtual appliance or a Hyper-V virtual 
appliance. 

Deploy the VMware Virtual Appliance

Follow this procedure to deploy a VMware virtual appliance. When you run Quick Setup, you 
configure the virtual appliance as an RSA Authentication Manager 8.1 primary instance or replica 
instance.

Before You Begin

Copy the RSA Authentication Manager OVA file from the directory in the kit to a location that the 
VMware vSphere Client can access.

Procedure

1. In the VMware vSphere Client, log on to VMware vCenter Server, or log on to the VMware ESX 
or ESXi server (VMware Hypervisor). VMware vCenter Server is not required to deploy the 
virtual machine.

2. Select File > Deploy OVF Template to start the wizard.

3. On the Source window, browse to the RSA Authentication Manager OVA file.

4. Follow the wizard to deploy the template. 

5. On the Ready to Complete window, review your settings, and click Finish. VMware requires 
approximately five minutes to deploy the virtual appliance.

6. Power on the virtual machine.

7. Select the virtual appliance, and click the Console tab. The VMware OS Console tab displays the 
progress of the virtual appliance deployment.
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8. Wait for 30 seconds to select the default keyboard layout, English (United States). To choose 
another keyboard layout, click any key and follow the instructions on the screen.

9. If you are deploying the virtual appliance directly on the ESXi platform, the OS Console prompts 
you to enter and verify the virtual appliance network settings.
If you are deploying the virtual appliance through VMware vCenter, you already entered the 
network settings in the wizard.

10. When the virtual appliance is deployed, the OS Console displays the Quick Setup URL and the 
Quick Setup Access Code. Record the following required information:

• The Quick Setup URL includes the IP address you provided earlier in this procedure.

https://<IP Address>/

Quick Setup uses an IP address. The administrative consoles that are available after Quick 
Setup completes use a fully qualified domain name (FQDN).

• The Quick Setup Access Code is required to initiate Quick Setup.

Deploy the Hyper-V Virtual Appliance Through the Hyper-V Virtual Machine 
Manager Console

Follow this procedure to deploy a Hyper-V virtual appliance through the Hyper-V System Center 
Virtual Machine Manager (VMM) Console. Deployment through the Hyper-V Manager is also 
supported. When you run Quick Setup, you configure the virtual appliance as an RSA Authentication 
Manager 8.1 primary instance or replica instance.

Before You Begin

• Copy the RSA Authentication Manager Hyper-V virtual appliance file, 
rsa-am-hyper-v-virtual-appliance-8.1.1.0.0.zip, to an existing Hyper-V VMM library server or a 
shared folder on a Microsoft Windows 2012 R2 machine that can be added as a library server. 

• Unzip the file to the current location.

Note: Do not rename the VHD files. 

Procedure

1. Log on to the Microsoft Windows 2012 R2 machine that has the Hyper-V VMM Console installed.

2. (Optional) If the disk1 and disk2 VHD files are not located on an existing library server, add the 
location of the VHD files as follows:

a. Open the Hyper-V VMM Console, and log on to the VMM server.

b. On the Home tab, click Add Library Server.

c. Select or enter the library server logon credentials, and click Next.

d. Search for the server that contains the VHD files, select the server, and click Next.

e. Select the share that contains the VHD files, and click Next.

f. Click Add Library Servers.

3. Run the Virtual Machine Manager Windows PowerShell module as an administrator, and change 
directories to the location of the Windows batch file.
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4. To create a Hyper-V virtual machine template, type the following, and press ENTER: 

.\create_vm.bat -vmm -server FQDN_or_IP address -port port_number 
-libraryserver 'Windows_Directory_Path' -templatename Template_Name

Where

• -vmm makes the batch file run in VMM mode.

• -server FQDN_or_IP address is the fully qualified domain name or IP address of the VMM 
server.

• -port port_number is the optional argument for the VMM server port. If you do not specify this 
option, the system uses the default value 8100.

• -libraryserver 'Windows_Directory_Path' is the location of the library server managed by the 
VMM where the VHD files are uploaded. 

• -templatename Template_Name is the optional argument for the name of the template. Specify a 
template name if you might run the batch file more than one time. If you do not specify a 
name, the system uses the default value RSA Authentication Manager Appliance VM 
Template. 
The template name must contain 69 or fewer characters and follow Windows naming 
conventions. For example, the filename cannot contain the characters \ / : * ? " < > and |.

For example, run .\create_vm.bat -vmm -server 192.168.0.0 -libraryserver 
'\\windowshyperv.yourorganization.com\libraryshare' to create a Hyper-V virtual machine 
template that uses the default port and template name.

5. If you are prompted by a security warning, type r to run the script. By default, PowerShell has a 
restrictive security policy that does not trust scripts that you download from the Internet.

6. When you are prompted, enter administrative credentials for the VMM server.
After the script successfully creates the virtual machine template, you can use the Create Virtual 
Machine wizard in the Hyper-V VMM Console. 

7. If you have not already done so, open the Hyper-V VMM Console, and log on to the VMM server.

8. Click Library > Templates > VM Templates.

9. Right-click the name of the virtual machine template, and select Create Virtual Machine. The 
Create Virtual Machine wizard launches.

10. On the Identity window, enter a name for the virtual appliance, and click Next.

11. On the Configure Hardware window, keep the default hardware profile, and click Next. The 
PowerShell script automatically configured the virtual machine template.

12. Follow the wizard to deploy the virtual appliance. On the Select Networks window, choose a 
network connection. You must connect the appliance to your network before it is powered on.

13. On the Summary window, click Create.

14. After the virtual appliance is successfully created, power on the virtual appliance, and connect to 
the virtual appliance through the VMM Console.

15. Wait for 30 seconds to select the default keyboard layout, English (United States). To choose 
another keyboard layout, click any key and follow the instructions on the screen.

16. Read the End User License Agreement (EULA), and type yes to accept it.

17. When the OS Console prompts you, enter and verify the network settings for the virtual appliance.
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18. When the virtual appliance is deployed, the OS Console displays the Quick Setup URL and the 
Quick Setup Access Code. Record the following required information:

• The Quick Setup URL includes the IP address you provided earlier in this procedure.

https://<IP Address>/

Quick Setup uses an IP address. The administrative consoles that are available after Quick 
Setup completes use a fully qualified domain name (FQDN).

• The Quick Setup Access Code is required to initiate Quick Setup.

Deploy the Hyper-V Virtual Appliance Through the Hyper-V Manager

Follow this procedure to deploy a Hyper-V virtual appliance through the Hyper-V Manager. 
Deployment through the Hyper-V Virtual Machine Manager Console is also supported. When you run 
Quick Setup, you configure the virtual appliance as an RSA Authentication Manager 8.1 primary 
instance or replica instance.

Before You Begin

Extract the RSA Authentication Manager Hyper-V virtual appliance file, 
rsa-am-hyper-v-virtual-appliance-8.1.1.0.0.zip., but keep the original .zip file. After you create the 
virtual appliance, running the new appliance modifies the VHD files. For each virtual appliance that 
you deploy, you need to extract a new set of VHD files from the .zip file.

Procedure

1. Log on to the Microsoft Windows 2012 R2 Hyper-V host machine.

2. Copy the RSA Authentication Manager Hyper-V virtual appliance file, 
rsa-am-hyper-v-virtual-appliance-8.1.1.0.0.zip, to a location on the Microsoft Windows 2012 
R2 Hyper-V host machine. 

3. Unzip the file to the location where you want to create the virtual appliance.

Note: Do not rename the VHD files. 

4. Run Windows PowerShell as an administrator, and change directories to the location of the 
Windows batch file. The virtual appliance is created in the directory where you run the script.

5. To create a Hyper-V virtual machine, type the following, and press ENTER: 

.\create_vm.bat -name virtual_machine

Where
-name virtual_machine is the name of the virtual machine. Specify a name if you might run the 
batch file more than one time. If you do not specify this option, the virtual appliance uses the 
default name RSA Authentication Manager Appliance.
For example, type .\create_vm.bat -name AuthenticationMgrPrimary to create a virtual 
appliance with the name AuthenticationMgrPrimary or type .\create_vm.bat to create a virtual 
appliance with the default name RSA Authentication Manager Appliance.

6. If you are prompted by a security warning, type r to run the script. By default, PowerShell has a 
restrictive security policy that does not trust scripts that you download from the Internet.

7. When prompted, type y to confirm that you want to create a new virtual machine.
After the script successfully completes, connect the virtual appliance to your network.
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8. In the Windows Start menu, click Server Manager > Tools > Hyper-V Manager.

9. In the Hyper-V Manager, select the node and host from the left pane. 

10. In the Virtual Machines pane, select the new virtual machine.

11. In the Action pane, under the virtual machine name, click Settings.

12. In the navigation pane, click Add Hardware and configure the Network Adapter, or click 
Network Adapter and select a virtual switch. Do not use the legacy network adapter. The legacy 
network adapter is not supported.

13. In the Actions pane, under the virtual machine name, click Start, and Connect.

14. Wait for 30 seconds to select the default keyboard layout, English (United States). To choose 
another keyboard layout, click any key and follow the instructions on the screen.

15. Read the End User License Agreement (EULA), and type yes to accept it.

16. When the OS Console prompts you, enter and verify the network settings for the virtual appliance.

17. When the virtual appliance is deployed, the OS Console displays the Quick Setup URL and the 
Quick Setup Access Code. Record the following required information:

• The Quick Setup URL includes the IP address you provided earlier in this procedure.

https://<IP Address>/

Quick Setup uses an IP address. The administrative consoles that are available after Quick 
Setup completes use a fully qualified domain name (FQDN).

• The Quick Setup Access Code is required to initiate Quick Setup.

Step 4: Set Up the Primary Instance

Quick Setup configures the virtual appliance as the primary instance. You must configure a primary 
instance before you deploy any replica instances. 

RSA recommends a deployment containing both a primary instance and a replica instance. The RSA 
Authentication Manager Base Server license and the Enterprise Server license both include permission 
to deploy a replica instance.

Administrative Accounts

Before running Quick Setup, you should understand the three administrative accounts that are created 
when you configure your virtual appliance as a primary instance:

• Super Admin. Super Admins can perform all Authentication Manager administrative tasks. Any 
Super Admin can create a new administrator in the Security Console.

• Operations Console administrator. Operations Console administrators can perform 
administrative tasks in the Operations Console.

• Appliance Operating System Administrator. Use the rsaadmin account if you require access to 
the appliance operating system for advanced maintenance or troubleshooting tasks.

For more information, see the appendix “Administrative Accounts” in the Setup and Configuration 
Guide.
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Run Quick Setup on the Primary Instance

Keep the virtual appliance on a trusted network until Quick Setup is complete. The client computer and 
browser used to run Quick Setup should also be on a trusted network.

Before You Begin

Copy the license file to a location that is accessible to the browser that is used to run the primary 
appliance Quick Setup. Do not unzip the file.

Procedure

1. Deploy the virtual appliance. For instructions, see Step 3: Deploy the Virtual Appliance.

2. Launch Quick Setup with the URL provided at the end of virtual appliance deployment. Enter the 
Quick Setup URL in the browser, including https, and press ENTER:

https://<IP Address>/

where <IP Address> is the IP address of the appliance.
If your web browser is configured for an enhanced security level, a warning states that this URL is 
not on the list of allowed or trusted sites. To continue, click the option that allows your browser to 
connect to an untrusted site. 

3. When prompted, enter the Quick Setup Access Code, and click Next. The Primary and Replica 
Quick Setup window displays.

4. Click Start Primary Quick Setup, and follow the instructions on the screen.

5. Record all of the passwords for the administrative accounts that you create during Quick Setup. 
The operating system password is required to access the primary instance. For security reasons, 
RSA does not provide a utility for recovering the operating system password.
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6. After the instance is configured, you can click the Security Console or Operations Console URL 
links to open those consoles. The Security Console or Operations Console URL links require a 
fully qualified domain name (FQDN).

Note: The FQDN must resolve to your appliance. If you are having trouble connecting to the 
consoles, verify the DNS configuration.

The first time you access the Security Console or the Operations Console, a warning appears 
because the default self-signed certificate created after Quick Setup is not trusted by your browser.

7. Accept the certificate to access the console and prevent the warning from occurring again. For 
more information, see the chapter “Deploying a Primary Appliance” in the Setup and 
Configuration Guide.

Note: If you plan to migrate from RSA Authentication Manager 7.1, the first import you complete 
on RSA Authentication Manager 8.1 overwrites all existing data in the deployment and removes 
attached replica instances. For more information, see the RSA Authentication Manager 7.1 to 8.1 
Migration Guide.

Log On to the Consoles

After you have completed Quick Setup, you can use the following links.

Console URL

Security Console https://<fully qualified domain name>

https://<fully qualified domain name>/sc

https://<fully qualified domain name>:7004/console-ims

Operations Console https://<fully qualified domain name>/oc

https://<fully qualified domain name>:7072/operations-console

Self-Service Console If there is no web tier, enter:

https://<fully qualified domain name>/ssc

https://<fully qualified domain name>:7004/console-selfservice

After installing a web tier, enter:

https://<fully qualified virtual host name>

https://<fully qualified virtual host name>/ssc

https://<fully qualified virtual host name>/console-selfservice

If you change the default load balancer port, enter:

https://<fully qualified virtual host name>:<virtual host port>/

https://<fully qualified virtual host name>:<virtual host port>/ssc

https://<fully qualified virtual host name>:<virtual host port>/console-selfservice
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For example, if the fully qualified domain name of your appliance installation is “host.mysite.com”, to 
access the Security Console, enter the one of the following URLs in your web browser:

https://host.mysite.com/

https://host.mysite.com/sc

https://host.mysite.com:7004/console-ims

If your web browser is configured for an enhanced security level, you must add at least one URL for 
each console to the list of allowed or trusted sites. Add any additional URLs that you intend to use. See 
your browser documentation for instructions about adding allowed or trusted sites.

To access the Security Console, enter the Super Admin User ID and password that you specified 
during Quick Setup. To access the Operations Console, enter the Operations Console user ID and 
password that were entered during Quick Setup.

Step 5: Set Up a Replica Instance

After you configure the primary instance, you can deploy another virtual appliance and set up a replica 
instance.

Keep the virtual appliance on a trusted network until Quick Setup is complete. The client computer and 
browser used to run Quick Setup should also be on a trusted network.

Before You Begin

A primary instance must be deployed on the network.

Procedure

1. On the primary appliance, log on to the Operations Console, and click Deployment 
Configuration > Instances > Generate Replica Package. For instructions, see the Operations 
Console Help topic “Generate a Replica Package.”

2. Deploy a virtual appliance. For instructions, see Step 3: Deploy the Virtual Appliance.

Note: If you are using the Hyper-V Virtual Machine Manager (VMM) Console and you already 
created a Hyper-V virtual machine template, you can begin with step 7 in the VMM procedure.

3. Launch Quick Setup with the URL provided at the end of the virtual appliance deployment. Enter 
the Quick Setup URL in the browser, including https, and press ENTER:

https://<IP Address>/

where <IP Address> is the IP address of the appliance.
If your web browser is configured for an enhanced security level, a warning states that this URL is 
not on the list of allowed or trusted sites. To continue, click the option that allows your browser to 
connect to an untrusted site. 

4. When prompted, enter the Quick Setup Access Code, and click Next. The Primary and Replica 
Quick Setup window displays.
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5. Click Start Replica Quick Setup and follow the instructions on the screen.

6. Record the operating system password that is created during Quick Setup.
The operating system password is required to access your replica instance. For security reasons, 
RSA does not provide a utility for recovering the operating system password.

7. After the instance is configured, do one of the following:

• Click Begin Attach to attach the replica instance to the primary instance.

• Click Defer Attach to attach the replica instance at another time. When prompted, confirm 
your choice. The replica instance powers off. You can attach the replica instance the next time 
you power on the replica instance.

For instructions, see the Operations Console Help topic “Attach the Replica Instance to the 
Primary Instance.”

Web Tier Installation

Web tiers are not required, but your deployment might need them to address your network 
configuration or security requirements. Authentication Manager includes risk-based authentication 
(RBA), dynamic seed provisioning, and the Self-Service Console, which may be needed by users 
outside of the your private network. If your network includes a DMZ, you can use a web tier to deploy 
these services inside the DMZ. For more information, see the chapter “Planning Your Deployment” in 
the Planning Guide.
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Next Steps

After setting up the appliance, decide which of the following tasks to perform. You must perform all 
post-setup tasks on the primary instance.

Task Administrator’s Guide Chapter

Add Authentication Manager users To add users to the Authentication Manager internal 
database, see “Administering Users.”

To link to an external identity source, see “Integrating 
LDAP Directories.”

Assign authentication policies “Configuring Authentication Policies.”

Import tokens and assign users “Deploying and Administering RSA SecurID Tokens”

Set up risk-based authentication (RBA) “Deploying Risk-Based Authentication”

Set up on-demand authentication (ODA) “Deploying On-Demand Authentication”

Configure and customize end-user Self-Service 
for maintenance and troubleshooting.

“RSA Self-Service”
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Support and Service

RSA SecurCare Online offers a knowledgebase that contains answers to common questions and 
solutions to known problems. It also offers information on new releases, important technical news, and 
software downloads.

The RSA Ready Partner Solutions Directory provides information about third-party hardware and 
software products that have been certified to work with RSA products. The website includes 
implementation guides with step-by-step instructions and other information about interoperation of 
RSA products with these third-party products.
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